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Enterprise Reporting Portal (EREP)

Introduction

€ CME Group

Enterprise Reporting Portal (EREP) is browser-based tool that enables firm users to search, view, and print
or download CME Group pre-processed reports. One handy feature of EREP is that users may save any
report listed on EREP to file, zip, or PDF. This feature offers customers the flexibility to review and

reconcile reports within various formats.
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How do | access EREP?

1. To access EREP, logon to CME Group Connect by entering the following in your internet browser:
http://connect.cme.com.

2. Enter your Username and & CMEGroup  CME Group Connect

Password. St

If you dO not haVe thIS InfOI’matIOI"I, Login to CME Group Connect Message Center

please refer to the Message Center username \Welcome to CME Group Connect. Please enter your login I and password on the left and ensure the

ct product is selected. If you b b CME Group Connect, pl tact CHE
on the CME Group Connect s e e S e
homepage for aSS|Stance poict  ClE Pt = after hours support, please contact CME Group; ET Operations at (312)330-8200
. If you have problems accessing the CME Group EOS or CNE Group Globex products, please contact the

3. Ensure PrOdUCt is set to CME CME Group Giobex Control Center at (312)456-2391

PO rtal . Details on availabllity during holidays may be found at CME Group Holiday Calendar.

To access CME Group Connect testing for Certification and End to End Applications please navigate to

4. C|ICk LOgIn . http:ficonnectcert cme.com.

Upon successful login, you will be
directed to the CME Applications menu.

5. Click EREP.

cmeconnect

Logged in:

I

H EREP

EREP Home Page

The Home Page will identify any important system messages and key documentation.

< CME GI’OUD Enterprise Reporting Portal Home Page

Production Parallol: Efs.
Diswct by 27 o 2011, Te

Reports Availability: Consut the Repon:

OverviowlFAQ

Retoasn Notes (Upcoming Faatisres)

Fuature

NOTE: If you do not have access to CME Group Connect or the EREP icon, please contact CME Group's
Firm Support Hotline at firmsupport@cmegroup.com or 312-930-3444 (option 2) between the hours of 6:30
am CT and 5:30 pm CT.
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How do | search for report in EREP?

1. Click the Reports tab to display the search page.

Welcor

-
FOUP | Enterprise Reporting Portal Home Page Th, A7 20110421 P COT

Contact Us| User Manual | Log Out

2. Select a Report Date. You can select Equals, Month to Date, Between or Last Month.

Report Date Report Id contains

Setween 20110425 |F and 20110426 [

Available Firms Selected Firms
COMEX
COMEX.
COMEX.
DME

Date Selection Operands (Identifies the date that the report was processed.)

Equals Equals specifies one date. The system default displays the current trading
day. Date format: YYYY-MM-DD

Month to | Month to Date automatically sets the beginning date to the first day of the
Date current month and the end date to the current trading day.

Between | Between specifies the beginning and end dates for a date range. Between is
also the default operand and is set to display from previous to current
business day.

Note: If the date range exceeds availability within EREP, no results will be
returned beyond the report retention period.

Last Last Month defaults the beginning and end dates to the first and last days of
Month the previous month.

3. Report ID contains (Optional). To display all reports for a firm leave blank.

The Report ID field allows the user to search for a string of numbers or letters across available report
IDs. The system will search for and return any report IDs or report names that contain the string
entered.

To limited the amount of reports you want to display use the Report Id field (i.e.; XTC, POS, 999).

Report Id contains
999

Global Operations Education 5
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4. The Selected Firms section will default with a list of firms. The list of exchanges and firms are based
on the users’ authorization.

To remove any firm from the Selected Firms’ list, click the ‘Remove’ button after highlighting the firm
name.

NOTE: To select a block of multiple firms, hold the Shift key and select the firms. To select various
multiple firms, hold the Ctrl key and select the firms.

5. Click Search.

NOTE: The Clear button will clear the search screen and reset to the default values.

Report Date

Equals - 20110425 [

Available Firms

Report Id contains

Selected Firms

COMEX
COMEX

Add > COMEX
DME
Add Al > bHE
DME
GEX

e

NYMEX

[ — NYMEX

)
o

The search results list will display. Reference Appendix 1 for Navigation

Search Results Page 15 of 52 | 155 Rows | Show Al V\eWA
15 3
EPer Go To Page: - Set Page Length SET Nest [
- BIBINIRIBUL
999 ACS210NYM NYMEX ACS EXECUTING AND CARRYING PERFORMANCE SUMMARY 2011-04-25
DME 999 POSA00 COMMODITY POSITION ADJUSTMENT BY FIRM 2011-04-25
999 POSE20E EQD GROSS POSITION CHANGE (PC) LISTING 2011-04-25
The following options are available from the drop-down window:
e View —
View =
e PDF
e Print PDF
o Zip Print
. Zip
e File File

Note: Reference page 9.

Is there a way to group the report names?

To sort any of the columns per one criterion at a time, click on the arrow.
[ Ffm> | Repotir | Reporthamea | tmer |

Global Operations Education 6
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How do | view reports in EREP?

*

Click the line item of the report to view in the search results list; a pop-up window will display the

selected report.

Search Results

[[dPrev.

ACS2Z10NYM
DME 999 POS500
DME 999 POSE20E

Page 15 0f62 | 155 Rows | Show Al V\Ewd
B setpage Lengtn: 3

. BTEINM 12131416

Go To Page: 15 SET

Next

HYMEX ACS EXECUTING AND CARRYING PERFORMANCE SUMMARY 2011-04-26
COMMODITY POSITION ADJUSTIENT BY FIRM 2011-04-25
EOD GROSS POSIHO NG 2011-04-26

Report Name »

I T

Export

[ Zp | Fie | PoF |

i

Navigation Search

B3 36

Al

[PO5520 CME CLEARING - MERCANTILE EXCHANGE FPAGE:
[BUSINESS DATE: 04/25/2011 GRCSS PCSITICON CHANGE (PC) LISTING RUN DATE:
ICYCLE: EOD 7 RUN TIME:
[EXCH: DME FIRM: 999 ORIGIN: POSITION ACCOUNT: PROFILE: .
ICOMMODITY CLASS: FINANCIAL
DME CMAN CRUDE OIL
ADJUSTED GROSS FINAL
[CONTRACT 50D TRADES ACS/RPS EXER/ASG POSITICHS POSITIONS BC-ADJ INTRA SFR INTER SER
Q 201106
LONG: Q Q o o Q o o Q o
SHORT: Ll 0 0 0 0 L] 0 L]
[COTALS ADJUSTED GROSS FINAL
IDME OMAN CRUDE OIL S0D TRADES ACS/RPS EXER/ASG POSITIONS POSITICNS PC-ADJ INTRA SPR INTER SPER
FUTURES LONG: Q Q o o Q o Q o
FUTURES SHCRT: Ll 0 0 0 0 L] 0 L]
COMBINED LONG: Q Q o o Q o Q o
COMBINED SHCRT: Ll 0 0 0 0 0 0 0
e When viewing a report in the action of ‘View’ the report will display in PDF format, the font cannot
be adjusted.
o When viewing a report in the action of ‘Print or PDF’ the report will display in PDF format, the font

cannot be adjusted, however you can use the Zoom function to increase readability.

BRSO el

Boglorm | = B

T
DL¥715-T CME GROUE FAGE:1
EUSINESS DATE: 03/30/2011 FINAL STORAGE CHARGES RON DATE:3/30/2011
FIEM REBCRT BN TIME:18:43:13
EACH: COMEX CLEARING FIRM TRADING FIRM TRADING FIRM NAME: ORIGIN:  HOUS
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& CME Group
Enterprise Reporting Portal (EREP)

How can | print from the Report search results list?

Print Function m

Note: The Print option from the drop down list defaults to print all pages of the PDF
version of the report. See Guidelines for Printing — Reference Appendix Il for
assistance on text and zip file printing.

1. Complete a report search.
2. Select Print from the action drop down option.
3. Click on the line item to print.
a. Pop-up window displaying the report to print will display.
b. The Print dialog window will display, make changes as needed and click OK.

Selected Firms

[coMEX
7/~ https://connectwdc.cme.com/erep/reportiction, ] ] |

Ig, https:{{connectwde.cme . com/erepjreportaction/, Danalnfo=, sesgsDhnpkjgzL pOtPEES+DLYT 1SF_2011-04-25.do? | & !
= B E & s iRy & | ® @[5~~~

— |
=N =N = Print =l

[~ Printer

Mame: “AMERCT REEYCO2-%erax6360 22E 0 ﬂl -

] Status:  Ready Comments and Forms:

Type:  Herox Phaser B3600M PS [Document and Markups -
e e E ]
T T T RIS Print Range - Preview: Composite

= all

£ Cument view
" Cument page
© Pages[1-8

I Reverse pages

Report Id - Page Handiing

Copies: = I Collate

200
305 Page Scaling: [More |
: :; | ¥ Auto-Rotate and Center
116 [ I Choose Paper Source by PDF page size
E210NY M NYMEX ACS EXECUTING AND CAR
™ Print ta file o £ 11.0%85
5500 COMMODITY POSITION ADJUSTME EEMIERLS UlLWE SR

[~ Print color as black Faper: 85 % 11.0in

5520E EOD GROSS POSITION CHAMGE (F 1811 J—

55201 ITD GROSS POSITION CHANGE (PC

E591NE NYMEX/COMEX/DME/GEX EOD DAl _Printing TiDSl Cancel |

Reference: Appendix IV — Configuring PDF to Print with LARGE TEXT — Fit to Page

Global Operations Education 8
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What functions are available in EREP Report Viewer?

e Users have various export options, and can navigate or search within the report.

Export Print Navigation Search

ﬁi| | o Al H

Export Functions

You have the option to export the report to ZIP, text file, or PDF. Within each option, additional features
may be available such as Open, Save, Print.

Export

[z | Fie [ PoF ||

Type Setup File
/2 Export Setup Zip - Microsoft Internet Explorer provided by Chicago == ﬂ

€] https:/fronnectwde, cme.com/erep],Danalnfo=. aesgsDhnpkigzL ptPteS+epartDetaldction

Export Range - Zip Do you want to open or save this file?
Zl P ' All (exchanges and fims)
-
Current Report 7 Name: CSTS30IDY1_2011-05-26.2p
@ Current Page _
C Pages: Type: Compressed (zipped) Folder
Enter page numbers andfor page ranges From: connectwdc.cme.com

separated by commas. For example: 1,5,10-17

| OK f Cancel | Open | Save | Cancel I

/2 Export Setup File - Microsoft Internet Explorer provided by Chicagy =100 ] File Download x|

2| https:/fcornectwdc. s com{erep, Danalnfom,assgsDhnpkiozL pOEPLES+reportDataliction
Export Range - File Do you want to open or save this file?

c All (exchanges and firms)
C Current Report
@ Current Page

FILE

Mame: CSTGI0I0Y1_2011-05-25.kxt
Type: Text Document

@

Pages:
9 From: connectwdc.cne.com

Enter page numbers and/or page ranges
Open | Save | Cancel I

separated by commas. For example: 1,5,10-17

EEY Ry

/7 Export Setup PDF - Microsoft Internet Explorer provided by Chicag =10 Redlrected to a PDF page
@ | https:j fconnectwdc .cme, comf=rep/, Danalnfo= aesgsDhnphigeLpOtPLeS+report DetailAction
P D F Export Range - PDF I@ https:ﬂcomectwdc‘cme‘tomferepfveportActionLDanaInh:‘aesgsDhnpk]qupUtPt65+CSTESDID\‘I_2011-05-25‘@
C ol (exchan | | 3
ges and firms) : z @ 0 W AT Y
i v 11z ] o BB B M
(‘CunEmRepnn HHE‘ 0 *ri m\j “l‘J\J /
@ Cyment Page .1 I l—

Enter page numbers and/or page ranges
separated by commas. For example: 1,5.10-17

[ O | Cancel

Global Operations Education 9
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Export Print Navigation
Print Iy | e | PF  Pin| B  ~8H
Mame | VMERCTREE VI rencaf M 2228 01 7] Tropatiat
STAICR0L CHICAG) MERCENTILE EXCHANGE Reacy T
BUSINESS DATZ: 05/25/1% SEAN RECA? IEDGER )
YD RN =0 WE=S e e HN
TERING QRGMTZATION: OF 1 ExportSetup Print - Hicrosof Inkerne Exploer provided iy Ci Jﬂﬂ
CURRENCY DESCRIPTION 18 . onnec: aecupaomereg D= sk 5 I '\r@§

ND = ADSTRALIAN DCLLAR Export Range - Print

(D = CATADIAN DOLLAR o
GF = SIS A Aleuchanges and fims|

I = DETISEE WARR € Crthn

TRE = FRENCH ERANC
GEP = BRITISH POTHD
JFY = JRPANESE ¥2H
I = MEXICAN PE30
HOE = NORWEGIAN KRCNE
D = NEN ZEAIAND §

P 7 s Prpes Seusce by FOF g s
Bt page rumoers andiy page anges
separaed ay commas. For example: 15,147

I P tofle

Documert 110505
T P e s bk Pom 8521100

i
0
0
0
0
IR = I | Copm Page
0
1
0
0
0
0

Nm PirtngTos | _Advarcad | o8 e |

L]  —

Print All Exchanges and Firms

1. Complete a search for a specific Report ID.
2. The Selected Firms section should have ‘all’ Firms and Exchanges listed.
3. Click Search.

Report Date Report Id contains
Between 2120110525 | ang 20110526 | DLV635
Available Firms Selected Firms

CBT 010 SUNGARD GCC TEST
CBT 998 GLOBEX TEST FIRM
CME 010 SUNGARD GCC TEST
CME 998  GLOBEX TEST FIRM

H HE

998 DLV635 METAL MONTH TQ DATE DELIVERY NOTICES 2011-05-25 20:25:36

| Clear | Search |
Search Results Page 10of1 | 2Rows | Show All V\EW;I
1 10
[ Prev Go To Page: Set Page Length: Next
1
CME 010 DLVE35 METAL MONTH TO DATE DELIVERY NOTICES 2011-05-25 20:25:36

CME

In the example above two firms are listed; to print both firms together:
4. Select action View from the drop down list.

5. Select the desired report. The report will display in the Report Viewer.

Global Operations Education
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Export Print Navigation
| Zip | R R— I | GoTo || l ?/
DLVE35-T CHME GROUP RUNM DRTE: 05/25/2011 y
BUSIMESS DATE: O05/25/2011 MCONTH TC DATE DELIVERY HOTICES RUM TIME: 20:16:26
FRODUCT GROUF: METALS

T FULURES

Click Print. The Export Setup Print dialog box will display.
Click All (exchanges and firms) radio button.

/= Export Setup Print - Microsoft Internet Explorer provided by Chicag B ] 4

£ | https:/iconnect.cmegroup.com/zrep/, Danalnfo=, aesgsDhnpkigzLpOtPLES+repartDetailbctic | b |
Export Range - Print

C Current Report
C Current Page
O Pages: |
Enter page numbers and/or page ranges
separated by commas. For example: 1,5,10-17

[oc ] carc

8. Click OK.
The report will print all exchanges and firms applicable for the selected report.

Note: The ‘All Exchange and Firms’ feature is available for all export and print options (Zip, File, PDF, and
Print).

Navigation Function

Navigation

1. Enter page number.

I 1
2. Click the Go To button. Ll

Other buttons:

a. First Page

Page Number

b. Previous Page

c. Next Page

EERDE

d. Last Page

Global Operations Education 11
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Search Function

Search
1. Enter text.

2. Click the Find Next button. [ <] CAD -]

Find Previous
Button

Find Next
Button

Export Print Navigation Search
Zi G 1 of2 CAD
e e e L L L1 L L}
STE30R0L CHICAGO MERCANTILE EXCHANGE PAGE: 1
BUSINESS DRTE: 05/25/11 SPAN RECRP LEDGER RUN DATE (CST): 05/25/11
YCLE: ITD  RUN = 001 MODE = § EXCHANGE RATES RUN TIME (CST): 12:53:1¢4
FLEARING ORGANIZATION: CME
CURRENCY DESCRIFTION RATE RATE TYPE
AUD = AUSTRALIAN DOLLAR 0.6691201071 ASK
‘ CAD = CANADIAN DOLLAR 0.7965588657 ASK
CHF = SWISS FRANC 0.8831581736 ASK
DEM = DEUTSCHE MARK 0.6712588054 ASK
EUR = EURO 1.3128700652 ASK
FRF = FRENCH FRANC 0.2001257512 ASK
GBP = BRITISH POUND 1.4494232137 ASK
JPY = JAPANESE YEN 0.0121951220 ASK
MXN = MEXICAN PESC 0.0714898484 ASK
NCK = NORWEGIAN KRONE 0.1433712311 ASK
NZD = NEW ZEALAND § 0.5431535495 ASK
SER = SWEDISH KROMA 0.1207292044 ASK
LUD = AUSTRALIAN DOLLAR 0.6691201071 BID R
-~rnzaRT, B —
57 BID [ e

Contact Us

For help with Enterprise Reporting Portal contact CME Clearing Services at 312-207-2525 or email
ccs@cmegroup.com.

For user security inquiries contact Firm Support at 312-930-3444 (option 2) or email
firmsupport@cmegroup.com.

Log Out

To exit the system, click the Log Out link.

User On-line Manual

To display an on-line copy of the manual, click the User Manual link or go to
http://www.cmegroup.com/clearing/systems-operations/user-guides.html.

Global Operations Education 12
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Appendix | — Navigation

There are multiple ways to navigate through your data. If you do not have more than one page of data,
some of the below options will not be available.

Show All — selecting this hyperlink (located in the upper right-hand corner above the Search
Results window) will change the display to show all transactions on one page. Use the scroll bar on
the right of the browser window to scroll through the data.

Paginate — this hyperlink will appear after the Show All hyperlink has been selected. Use this to
change the display back to show one page of data at a time.

Prev and Next — selecting the previous or next hyperlinks will bring you to the previous or next
page of data.

Go to Page — allows you to enter a specific page number to view. To use this feature, type in a
page number and click the “Go” button.

Set Page Length — allows you to select the number of rows of data you would like to see per page.
To use this feature, type in a number and click the “Set” button.

1 2 3 4 - selecting one of these hyperlinks will bring you to that specific page.

Sorting Columns — You can sort the column data in ascending or descending order. Select the
arrow next to the header of the column you would like to sort. Data can only be sorted by one
column at a time.

OEEEEE O

Search Results w w Page 16 0f62 | 185 Rows | Show Al |View ]
- 15 jcal 3
EPer Go To Page: Set Page Length: SET Next ]
6783011213115,
2011-04-25

DME 999 ACS210NYM NYMEX ACS EXECUTING AND CARRYING PERFORMANCE SUMMARY
DME 999 POS500 COMMODITY POSITION ADJUSTMENT BY FIRM 2011-04-25
999 POS520E EOD GROSS POSITION CHANGE (PC) LISTING 2011-04-25

Note: Time Column — is used for Intra Day reports the Intra Day time will display.

COMEX 999 POSE201 TD GROSS POSITION CHANGE (PC) LISTING 2009-03-03

Global Operations Education 13
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Appendix Il — Guidelines for Printing
Page Breaks

To display the page breaks, open the file within a more advance text editor such as WordPad. Notepad
does not have the functionality to be able to recognize the form feeds.

WordPad

1. Download the report within File or Zip format.

rieveminad ]
Do you want to open o1 save this fle?
':] N DAVZNO0_2081-04-25 0

Typer Tek Document
Fro connectwde.cme.com

o | s )

Search Resul Page 1 of 165 | 155 Rows
'a b your computer | you o ol sk e source, o nal open &
— Ge o sweihe e Mhal's e sk
(& Praw Bisa B
[ tomsee | hm e e | e | e |
COMEX DLV200 DELIVERY INTENT AUDIT TRAL REPORT 2011:04-25

e
T T S Y

2. Click Save. 10y
ser[omr  H 0200

¥

HyCorpater

1
[ File 1ane: CLY200_2011- -2 14t | Save
Sevzathpe | Ted Coomerl M Cancel

3. A Download complete dialog box will display, click Close.

4. To open the file, right click on the file name and select Open With.

5. Click WordPad.

Fil= Edit e Fawvorites Tools Help

G pack -~ o - [T | S0 search [ Folders | [E==1-

address [[C <:\Documents and SettinasikwalkeriDesktop\EREP

- | rMame

1 Size | Tvpe | oa
9 KB Text Document 4z

File and Folder Tasks = 201 1-0<4-25. kxk

O
=i Renane this File pre
Frint

[y Mowe this File Edit

Copyw this File

3 Fublish this File to the
wieh

Conwvert ko Adobe POFE
Combine supported Files in Acrobat. ..

/e

=) E-mail this File
‘2w Print khis File
< Delete this File

MetWare Copy...

b Motepad
= Inkernet Explorer

K3 Scan For threats. ..

Py Send To >

octher PI =
s iiases “hoose Program. ..

[ Deskiop Cuk

Copy
3 ™My Documents
'.:g My Compukber “reate Shorktcuk
WD My Metwork Places Bel=E=

Rename

- Froperties

Details =

Global Operations Education 14
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6. Click Print Preview to display the report and page breaks.

[ ouvTisP_2011-04-250xt - WordPad

Page Breaks

M Legal paper should often print without having to adjust additional settings.
(File> Page Setup->Paper->Size = Legal)

M To fit within 8X11, Margins or Orientation may need to be adjusted.
(File>Page Setup ->Margins)

[ Font size may also need to be adjusted to fit the page. (File=>Format > Font)

0 The setting may need to be modified to fit the characteristics of each file.

0 The ‘print preview’ will confirm the settings are correct before printing.

Global Operations Education 15
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Appendix Ill — Setting WordPad Preference

To avoid having to set WordPad each time you open a file change the preferences.

, : - sveas 2x=
1. Right Click the file name.
Savein | ) EREP Q2 E
2. Select Open With. E [£] pLy200_2011-04-25 bt
[|oLizise_z011-04-25,
3. Select Choose Program. My Recent o
Dacume Open
Prink
Edt
H Convvert to Adobe POF

T Combine supported Files in Acrabat...

My Doct. N MetWare Copy...

Open With 3 3 Natepad

EI { 5can for threats. . A wordead

@ Internet Explorer
e

My Computer Sl

ii Cuk

Choose Pragram. .,

- ] Choose the program wou want ko use ko open this File:
vl
File: DLYWFISP_2011-04-25, k=t

. — Programs=
4. Click WordPad.
Recommended Programs: -

5. Click checkbox. 8 Incernet Exlorer
3 MNokepad

j WiordPad @

Other Programs.:

- Adobe Acrobat 5.1

Ep Adobe Captivate

B Adobe Reader 5.0 a
[ Microsoft Office Excel

@ Microsoft Office Picture Manager

[rS Microsoft OFfice PowerPoink

The next time you open a file it will =

=l
PN W, SRR =f SN = o S T [ |

automatically open in ‘WordPad'. ¥ always use the selected program ko open this kind of file l

Erowise, .. |

If the program wou want is not in the lisk or on wour computer, yvou can ook,
for the appropriate program on the Web,

[V always use the selected program to open this kind of file l‘

6. Click OK.

o] Cancel
O |

Global Operations Education 16
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Appendix IV — Configuring PDF to Print with LARGE TEXT - Fit to Page

1. Select the ‘PDF’ button.
2. Select the Export Range.
3. Click OK.

osoft Internet Explorer provided by Chicago Mercantile Exchange In

l&] hitps:jcannect. amegroup. comjerepf, Danalnfo=. aesgsDhnpkjgzL pOPHSS-+reporbAction, doPsubmd=FetchR eportDatal

fonfType=\izw_From_Searchizp:

Export Print Navigation

Search

Ea B < HE

(o e Tor |

5TE30R01 CHICAGO MERCANTILE EXCHANGE BAGE: 1
BUSINESS DATE: 05/31/ SPAN RECAP LEDGER RUN DATE (CST): 05/31/11
YCLE: ITD RUN = 00 =5 EXCHANGE RATES RUN TIME (CST): 12:32:04

CLEARING ORGANIZATION: Cl
CURRENCY DESCRIPTION RATE RATE TYPE

AUD = AUSTRALIAN DOLLAR 0.6691201071 AS'{

CAD = CANARIAN nATTAD n mogccangen

o 21
DE‘ g Pitpe:fjornect cvegroup comjerep/, Danalno—, aesgsDhnpkiqal pOEPES +reportDetalictic | £ \ R=~|

N Export Range - PDF

All (exchanges and firms)

© Current Report

C Current Page

C Pages:

Enter page numbers andor page ranges

separated by commas. For example: 1,5.10-17

52 bore [T A Intemet [V - [Hise - 4
JPY = JAFENESE VEW o TIZITsIE0
MXN = MEXICAN PESO 0.0714898484 51D

The PDF file will display.

Print

Export

 Zip | Fite | POF |

Navigation

e

CSTE30RO1 CHICAGOC MERCANTILE EXCHANGE
PUSINESS DATE: 05/31/11 SPLN RECRP LEDGER
CYCLE: ITD RUN = 001 MODE = 5 EXCHRWNGE RATES
CLEARING CORGANIZATICN: CHME
CURRENCY DESCRIPTICHN RATE RATE TYPE
AUD = AUSTRALIAN DOLLAR 0.6691201071 ASHE
CAD = CANADIAN N ToeccesesT P
CHF = SWISS FRANE ;Iglél
DEM = DEUTSCHE ng, https:{{connect. cmegroup. com/erep/reportDetailfckion), Danalnfo=. aesgsDhnpkigzLpOtPEES+CSTE30IDY L _2011
EUR EURO —
FRF FRENCH FRR
GBP BRITISH PC
JEY JARPRNESE ¥
MXN = MEXICAN FE
NOK NORWEGIAN
HNZD NEW ZEALAMN
SEK SWEDISH KR
AUD =
CAD =
CHF =
DEM =
EUR =
FRF
GBP BRITISH PC
JBY JAPANESE ¥
MXMN MEXICAN PE
HNOEK = NORWEGIAN
HZD = HNEW ZEALAN
SEE = SWEDISH ER
DEM DEUISCHE M
FRF FRENCH FRR
GBP BRITISH PC
JBY = JAPANESE ¥
AUD = AUSTRALIAMN
CaD = CANADIAN O hd
CHF = SWISS FRAM[Bore |_|_|_|_|_|_|_ Unknown Zone a - w
CLP = CHILEAN PEST T.00Z 390000

e = wrTmoa N _acasacnnnn v

o2 Kl Il

PALCE
RUN DATE (CST)
RUN TIME (CST)
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4. Magnify the view to the desired size (ex: 130%).

4 CME Group

Export Print Navigation
[ zp | Fie | FoF | =3 I T o2
CHICAGC MERCANTILE EXCHANGE PAGE:
ATE: 05/31/11 SPAMN RECAF LEDGER RUN DATE (CST): 0O
RUN = 001 MCDE = 5 EXCHANGE RATES RUM TIME (CST): 12
RGANIZATION: CHME
¥ DESCRIPTION RRTE RATE TYPE
AUSTRALIAN DOLLAR 0.6691201071 ASK
CAMADIAN DOLLAR Ll —
SWISS FRRNC
DEUTSCHE MAREK
EURC
FRENCH FRANC
BRITISH POUND
JAPANESE YEN
MEXTCAN PESC
NORWEGIAN EKRONE
NEW ZEALAND %
SWEDISH KROMNL
AUSTRARLIAN DOLLAR
CRNRDIAN DOLLRR CSTE20R01 CHICAGC MERCANT
SWISS FRANC
DEUTSCHE MARK BUSINESS DATE: 05/31/11 SPAN RECA
EURO CYCLE: ITD RUN = 001 MODE = 2 EXCHANG
FRENCH FRANC CLEARING CRGANIZATION: CME
BRITISH POUND CURRENCY DESCRIPTION RATE RATE TYPE
JLPRNESE YEN AUD = AUSTRALIAN DOLLAR 0.€631201071 ASK
HMEXICAN PESC CAD CRMADIAN DOLLAR 0.7385588657 ASK
HORWEGIRN HRONE CHF = SWISS FRANC 0.8831E81736 ASK
NEW ZEALAND £ CEM = DEUTSCHE MARK 0.6712528054 ASK
SWEDISH HRONR EUR = EURD 1.2128700652 ASK
DEUTSCHE MARK
FRENCH FRANC FRF = FRENCH FRANC 0.2001457512 ASK
BRITISH POUND GBP = BRITISH DOUND 1.4454434137 ASK
JAPANESE YEN JPY = JADANESE YEN 0.0121551220 ASK
AUSTRALIAN DOLLAR MXN = MEXICAN PESO 0.0714B968454 ASKE
CAMADIAN DOLLAR 11.00 x 8.50 in 4| |
SWISS FRANC Dane [ [ [ [ | | & unknown zone Fa - .
CHILERN PESC 0. 0021300000
YULN 0.1542450000 EX
5. Click Print. Lﬁ
—
CHICAGC MERCANTILE EXCHANGE FPAGE 1
n SPRN RECAP LEDGER RUN DATE (CS5T): 05/31/11
L MODE = S5 EXCHANGE RATES RUN TIME (CS5T): 12:32:04
CHE
2 RATE RATE TYPE
DOLLAR 0.6691201071 LRSE
LLLE = S5 oo Rt
R I@, https:iconnect. cmegroup. comjerep/reportDetailac — Printer
MDD Status:  Ready Comments and Forms:
; Type: =erox Phaser B3600M PS IDocument and Markups b
1
RONE — Print Range — Preview: Composzite
s Lo |
pa £ Current view
POLLAR i~ Curent page
FLAR CsTe10R0L K 11 3
 Pages [1-4
ke EUSINESS DATE: 05/31/1 -
CYCLE: ITD BUN = of Subszet: IAII pages in range l
o CLEARING ORGANIZATICN: I~ Reverse pages
HD CURRENCY DESCRIPTION —poooHonding
i AUD = AUSTRALIAN I Copies: 1 = ¥ Collate 8.5
= CAD = CAMADIAN DOL
R?NE CHF = SWISS FRANC Fage Scaling: INone
= DEM = DEUTSCHE MAF
:2 EUR = EURO ¥ Auta-Rotate and Center
o FRE = FRENCH FRANG ™ Choose Paper Source by PDF page size
ND GBP = BRITISH POURM
2 JPY = JAPANESE YER
EE;TP_‘AR 11.00 % 8,50 in MXN‘ = MEXICAN PESC [T Printto file Document: 11.0 x 8.5 in
Done ,7 ,7 ,7 ,7 I Print colar &3 black Paper: 85 = 11.0in
o] T.002 1330000 1 124 1] |
0.1542450000 EX
RE 0.7300340000 EX Frinting TIDSI [ st | ok | Camcel |
1.4277560000 EX
C 0.2176700000 EX
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6. Adjust the settings to print per the CURRENT VIEW.

a. Print Range = Current View

b. Print Scaling = ‘Fit to Printable Area’

c. Uncheck ‘Auto Rotate and Center’

CME Group

Print

Navigation

— 1 of 2 N

CHICAGC MERCANTILE EXCHANGE

PLGE:

1

E: 05/31/11 7~ https://connect.cmegroup.com,/erep;| _iO|x[fuyN DATE (CST): 05/31/11

BUN = 001 MODE = https: t tDetailAction/, Danalnfo= DhnpkigeL pOEPLES-+CSTEI0IDYL 2011 | By U TIME (CST): 12:32:02
ENIZATION: CME & | https:/fconnect.cmegroup,com/erep/reportDetailAction, Danalnfo=. aesgsDhnpkjgeL pf + - =
DESCRIPTION Z 7 | @ . i | T 74 il M @& | @ @® [150% ) >

i i i ™ - D € o i
[USTRALIAN DOLLAR =5 0 - hd Y K | / |
IANADIAN DOLLAR 5 A li
H f* & |Finc =
WISS FRANC == x|
EUTSCHE MARK .
luro — Prinker
RENCH FRANC Mame: | “MERCTREENCO2:¥erox63500N-222E-01 7 | ﬂl
RITISH POUND Stalus:  Ready Caomments and Forms:
REANESE YEN Type:  Xerox Phaser 63600N PS [Document and Markups =
EXICEN PESO CSTE30R01 ]
CRWEGIAN EKRONE EUSINESS DATE: 05/31/11 [ PrintFange [~ Preview: Composite
EW ZEALAND $§ CYCLE: TTD RUN = 001 Al A
WEDISH KRONA CLEARING ORGANIZATION: Cl ' Current view
[USTRALIAN DOLLAR CURRENCY DESCRIPTION
[ANADIAN DOLLAR ] b e 1 N
WISS FRANC AUD = AUSTREALIAN DOLD - Pages|1 o4 3 A
EUTSCHE MAREK CAD = CANADIAN DOLLAI =
loro CHF - SwIss - Subset: IAII pages in range 'I
RENCH FRANC DEM = DEUTSCHE MARK = | Fieverse pages
RITISH POUND EUR = EURD ~Page Handing
MPANESE YEN FRF = FRENCH FRRNC Copies: 1 ¥ | Collate: | 85
EXICREN PE?O GBP = BRITISH POUND
ORWEGIAN iR?NE aJLY = JAPANESE YEN Page Scaling: IF\l to Printable Area LI I
EW ZEALAND 5 MXN MEXICAN PESC
WEDISH KRONA 100x8.500n 4] ( C I Auto-Rotate and Center
EUTSCHE MARK —l B
. Done

RENCH FRANC ™ Choose Paper Source by PDF page size
RITISH PCUND 1.0000000000 DMV
LPANESE YEN 1.0000000000 DMV
[USTRALIAN DOLLAR 1.0681480000 EX I Piint to file ’ e
IANADIAN DOLLAR 1.0234370000 EX . ptloetes e 2L
WISS FRANC 1.1724700000 EX I Pint color as black
HILEAN PESO 0.0021330000 EX 14111 |
AN 0.1542450000 X
EUTSCHE MARK 0.7300340000 EX Bt s ]| | Adwmed | Cameel |
URO 1.4277560000 X
RENCH FRANC 0.2176700000 EX
RITISH POUND 1.6463620000 EX

The file will print per the larger size and fit to page.
Note:
Print options can be adjusted to fit the selected report and desired print output.

o Page Range set to ‘Current View’ and Page Scaling set to ‘Fit to Printable Area’ prints the
current page or selection (ex: per the current view/larger font).

o Page Range set to ‘All’ and Page Scaling set to ‘None’ prints all pages within the selected report to
the largest available default size.

o Page Range set to ‘All’ and/or ‘Current View’ and Page Scaling set to ‘Tile all Pages’ allows the
user to manually scale using percentages (smaller or larger).

o Adobe Acrobat users have the option to use the ‘Edit Document Text’ tool to manually change the
font size.

For additional assistance, please consult Adobe Acrobat Print Support:
e Acrobat Printing Tips: http://kb2.adobe.com/cps/332/332720.html
e Acrobat Scale or Resize Pages: http://kb2.adobe.com/cps/896/cpsid_89621.html
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print |

 Frinter

Name: | “MERCTREE\CO2Xero#5360DN-222E-01 7 | Fropeties |

CME Group

Status:  Ready Comments and Forms:
Type:  Xerow Phazer 63600M PS IDDcumenl and Markups j
P X
1 Print Range rl? _I
&l  Printer
Mame: I'\\MEHETHEE\EEIE-Hem:-:ESBDDN-222E-D1j Properties |
" Curent page Statys  Ready Comments and Forms:
" Pages I1 -12 Type:  ¥erox Phazer 63500N PS IDDCUI'ﬂEﬂt and Markups ﬂ
1
o i ™ . : .
Subset I P J  Print Range ~ Preview: Composite
" Feverse pages + al
~ Page Handling " Cument view
Copies: 1 ¥ Collate " Currert page L u
. —— i F'ages|1 -12 " M 7
Page Scaling:  |Fit to Printable Area j -
Subset: Iﬁll pages in 1ange j
(TSN Fit (o Frintable Area =
Shiirk to Printable Area " Reverse pages -
[ Choose Pag Til o < ~Page Handling -
N———— Copies: 1 ¥ | Callate 85
I~ Pint to fle | | PageScaling: | Tile all pages j '
[ Print color as black . Mane :
Tile Scale: IEIE Fit to Printable Area
1 Shiirk to Prirtable Area e
— | [ CutMarks |Tile large pages
" Printing Tips | Advanced | Multiple pages per sheet
— Booklet Printing
I Pint tofile Units: Inches Zoom: 95%
I™ Frirt color a3 black
112(1] J
Frirting Tips | tdvanced I ]9 I Cancel
Printing Tips | Acrobat, Reader
Printing tips | Acrobat, Reader ——
Basic printing tasks Rattad contsm
Overview Eﬁ] - A |
= =l
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Appendix V — FAQ

Are the reports across exchanges?

Reports are per exchange unless otherwise stated.

Will other firms be able to view my reports on EREP?

Users can view only those reports and data specific to their security settings.
| selected areport and there was no information available?

EREP is designed to provide an entry for all firms for which the report is valid. In cases where there is no
data available for that date and firm, a message will be returned indicating ‘No Data Available’.

How do | remove a firm from the Selected firms’ window?

a. Highlight the firm to remove.
b. Click Remove

To highlight multiple firms hold the shift key, while selecting the firms, and then click Remove.
To remove all of the firms in the window, click Remove All.

When I try to download something from EREP, | get a Pop-up error.
How can | set my browser to allow Pop-ups from EREP?

To allow pop-ups change your Internet browser options:
a. Open Internet - click Tools > select Pop-up Blocker
b. Select one of two options: Turn Off Pop-up Blocker or Pop-up Blocker Settings

When you print using PDF is the font normal size?

The PDF font is displayed in maximum size to fit reports on page. For viewing comfort use the Zoom
function that will allow you to increase the view size.
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20 South Wacker Drive
Chicago, lllinois 60606-7499
Tel: 1 312 930 1000

Fax: 1312 466 4410
E-mail: info@cmegroup.com

Futures trading is not suitable for all investors, and involves the risk of loss. Futures are a leveraged investment, and
because only a percentage of a contract’s value is required to trade, it is possible to lose more than the amount of
money deposited for a futures position. Therefore, traders should only use funds that they can afford to lose without
affecting their lifestyles. And only a portion of those funds should be devoted to any one trade because they cannot
expect to profit on every trade.

The Globe Logo, CME®, Chicago Mercantile Exchange®, and Globex® are trademarks of Chicago Mercantile
Exchange Inc. CBOT® and the Chicago Board of Trade® are trademarks of the Board of Trade of the City of
Chicago. NYMEX, New York Mercantile Exchange, and ClearPort are trademarks of New York Mercantile Exchange,
Inc. COMEX is a trademark of Commodity Exchange, Inc. CME Group is a trademark of CME Group Inc. All other
trademarks are the property of their respective owners.

The information within this guide has been compiled by CME Group for general purposes only. CME Group assumes
no responsibility for any errors or omissions. Although every attempt has been made to ensure the accuracy of the
information within this guide, CME Group assumes no responsibility for any errors or omissions. Additionally, all
examples in this presentation are hypothetical situations, used for explanation purposes only, and should not be
considered investment advice or the results of actual market experience.

All matters pertaining to rules and specifications herein are made subject to and are superseded by official CME,
CBOT, NYMEX and CME Group rules. Current rules should be consulted in all cases concerning contract
specifications.

Copyright © 2011 CME Group. All rights reserved.
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